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You  can  find  some  additional  documentation  and  tutorials  for  easyHDR  
software on the http  s  ://www.easyhdr.com/  documentation  / website. 

• Tips and Tricks  

• EasyHDR Adobe Lightroom Classic plug-in  

• Working with layers and masks  

• Lens Correction  

• Ghost effect removal (deghosting)  

• What is the Exposure Value (EV)?  

• Astrophotography and the HDR image processing techniques.  

• HDR from MARS!  
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1. Introduction

EasyHDR is an image processing software that produces and tone maps High Dynamic Range
(HDR) images out of photo sequences taken with a digital camera. The program works on Windows 7,
8, 10, 11 (64-bit) and on macOS 10.12 and above.

The basic idea of High Dynamic Range image processing is depicted on the graphic below.

The first step is to take a set of photographs of the same scene, at different exposure settings.
EasyHDR will produce a so called HDR image (radiance map) out of these photos. The radiance map is
nothing else than just an artificial photograph, but what makes it different is the dynamic range that it
covers. It contains all the detail that was acquired on any photo from the set. The only problem is that it
cannot  be  simply  displayed  on  a  computer  screen  as  the  dynamic  range  of  this  display  media  is
relatively very low. Therefore another step has to be done – tone mapping or in other words: dynamic
range compression. The tone mapping can utilize a global or local operator to achieve the compression.
The global operator can give most realistic results but if the dynamic range is very high it is simply not
able to give good looking output as the details and colors get washed out. Therefore the local operators
are used in addition. They allow much higher level of compression, because they operate on the local
level. The details in the image are amplified, while the overall dynamic range is shrunk. This gives a lot
of possibilities. You can either make the result look very dramatic, or just achieve better realism by
smartly using the local contrast boost.

The modern DSLR cameras are equipped with better and better CMOS or CCD sensors in sense
of signal to noise ratio. In many cases just a single photo may be good enough for tone mapping. It
means that it is not always necessary to take an image sequence, which may sometimes be difficult
because of moving subjects or long exposure time needed. Because of that easyHDR allows you to tone
map just a single photograph – JPEG or for best results: RAW.
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2. User interface

The user interface of the easyHDR's main window consists of two base parts: workspace (1) and
a three-tab panel with tools and settings (2). Additionally, when working in the tone mapping mode a
third part appears (3). The panels are realizable and detachable. In order to change their width use the
grip on the inner border. To detach, just catch the upper bar with mouse and move it, or alternatively
click on the pin icon in the upper-right corner. Attaching back is done similarly. The position and size of
the whole window and the panels is restored when program starts. It is possible to reset the panels back
to their default positions by pressing F10 key (or in main menu: View → Reset window layout).

EasyHDR user interface.

The top of the window is occupied by main menu (5) and the tool box (4). The latter contains
some of the most important options of the main menu. Optionally, there can also be layers, crop  and
clone/healing toolboxes visible (7).

In the bottom, there is a status bar (6) which contains the main progress bar, zoom control for
the workspace and a label showing basic information about the image – dimensions and pixel value
under the mouse cursor. It also shows the last error or warning message. By clicking on it, you can see
the list of all errors and warnings. It is possible to re-enable the warnings to be shown in form of dialog
windows, if you previously selected not to see them again.

Additionally, when the color management is enabled, there are two buttons visible that allow fast access
to color profile options. Hover the mouse cursor over them to see the detailed information about color
profiles in use. The bottom of the workspace is also the place where The 3d LUT browser appears.
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There are two options for workspace maximization. F11 key (View → Maximize workspace)
hides the status bar, title bar and the main tool box. The “F” key (View → Full screen) additionally
hides the left (preset) and the right (tone mapping) tabs and it also hides all the other tool boxes. The
layers  tool  and  the  3d  LUT  browser  can  be  minimized  to  enlarge  the  workspace  during  normal
operation.

 2.1. Workspace

In the workspace you can view the input photos, a gamma-corrected HDR intermediate image
and of course the preview of tone mapping. What is visible depends on current step of operation, but it's
also possible to temporarily switch to other views using “Photo before processing” option. It gives an
easy way to compare the result with inputs. It also provides a way to examine the input images after
they are preprocessed (aligned and corrected for chromatic aberration).

Photo before processing.

Comparing the input photos with achieved result can be even easier with the  Before/after split view
option. When enabled, the view is divided, by an interactive splitter, into before and after processing
parts – horizontally or vertically. 

Before/after split view.
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The use of workspace is intuitive. Zooming can be done with mouse wheel, to pan around just press the
left or right mouse button. When in cropping mode, double click inside of the crop area to accept, or
away to cancel.

There is a possibility to change the background color of workspace. Just press the button in the lower,
left corner. 

The images are always shown at full resolution, the detail seen depends only on zoom factor. The view
is anti-aliased for best viewing quality. When tone mapping, processed is only the visible part of the
image, which ensures the best performance. It's possible to tune the performance of the program by
toggling live anti-aliasing and live tone mapping. For these settings please see the Program Options
section.

 2.2. Main tabbed panel

There are three tabs that correspond to three steps of processing. Switching between those tabs
changes the mode of operation. The steps are the following:

1. loading, preprocessing and HDR generation,

2. tone mapping,

3. post-processing (optional).

In  the first  step it's  possible to  create new project,  add and remove HDR sequence photos,
configure the EV values and finally, after optional preprocessing of the input photos, generate the HDR
image. When HDR image is generated and some pre-calculations are made, it's possible to work at the
second step – the tone mapping. At any time you can go back and regenerate HDR image with different
options, or realign input photos, etc. When you are happy with the parameters you can just save  the
result to file, or proceed to the last step – the post-processing. In both cases the whole image is first
processed at full resolution (previously only the visible area was processed). It's still possible to go back
to tone mapping or even to the first step. In that case however the applied filtering is lost.

Both, the tone mapping and post-processing panels are divided into several groups which can be
shown or hidden. In case of tone mapping all the settings are always used (automatically upon any
change) to generate the preview image in the workspace. 

Some of the groups (vignette, color adjustment and color saturation) allow disabling the effect (“eye”
button). This feature is useful when comparing the impact of the effect on the currently tone mapped
image. The other special button – the “padlock”, allows locking of the parameters, so that they are not
loaded from presets. Additionally, when lock is enabled, the preset thumbnails are regenerated each
time parameters are changed in the given group. 

The post-processing concept is a bit different. Each group is a separate tool which can be used to apply
changes to the current image. It means for example that when you apply Gaussian blur twice, the second
iteration is done on image produced by the first iteration. Undoing is possible just one step back, but it's
also possible to undo all applied post-processing. To do so, just switch back to tab 2 and again to tab 3.

For more details about each step please refer to the corresponding part of this document.
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Three-step approach to HDR processing.

 2.3. Additional tone mapping options panel

This panel appears only when you are working at the tone mapping step. It contains three tabs:
Presets, History and Navigator.

The  preset tab allows not only simple selection of built-in presets, but also defining and using user
presets. Preset selection is done by left mouse clicking on a thumbnail. You can edit the name of user
presets by just clicking on it. Right click on a user preset to get more options: delete, replace and move
to group. More information about presets can be found further in this document. 

The history tab gives undo / redo functionality. All the tone mapping settings changes are stored here
with a short, descriptive text. You can easily revert the parameter changes, while still having the ability
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to change your mind. Undo and redo is also accessible with Ctrl+Z and Ctrl+Y shortcuts.

The navigator tab contains an interactive, tone mapped, full image, thumbnail preview. The part of the
photo, currently visible in the workspace is marked with a rectangle. The selection can be moved by
dragging it with mouse, zooming is also possible with mouse wheel. 

The whole panel can be resized by grabbing the edge and moving it with the mouse. In effect, it allows
not only resizing the preset thumbnails, but also changing the way they are displayed – when the panel
is wider, the thumbnails are organized into more columns. The maximum size of the thumbnails can be
tweaked with a slider that appears on the top of the panel, when it's wide enough.

 2.4. High DPI support

EasyHDR supports high DPI display mode (for example 4K screens). It is enabled by default
when the high DPI desktop is detected. If needed, it can be forced to disabled state in the  Program
Options → Appearance.  Please note that on high DPI screens the program has to do 4 times more
calculations to provide live tone mapping preview. Therefore, it may be good to enable the live tone
mapping image resampling in Program Options → Performance.
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Comparison of the display quality on a HighDPI (left) and standard (right) display. 
You may need to zoom in to see the difference.

3. HDR radiance map generation

 3.1. Taking the photographs

The dynamic range (or the luminosity range) is the ratio between the brightest and the darkest
part of the photographed scene. The human vision can accommodate (in long term) the dynamic range
of 1014 : 1 (from starlight to bright objects in full sunlight). The light accommodation is achieved mostly
by chemical means, the iris is simply not as flexible. The human eye covers the dynamic range of about
100 000 :  1 at  one time,  just  the top dynamic range of most  real-world scenes.  In  comparison the
dynamic range of typical digital cameras is about 1000-4000 : 1 and in case of computer displays it is
even much worse. However, having the ability to cover a very wide dynamic range, the human brain is
not able to distinguish small changes in brightness and also human perception is logarithmic rather than
linear. Of course the digital camera and computer display design take advantage of that fact.

The camera chip (CCD or CMOS) responsivity is more or less linear. A 12-bit RAW image is
converted to an 8-bit per channel photo using a compression curve stored in the camera in a Look Up
Table (LUT). So the whole dynamic range that the camera can cover is compressed (fitted) into 8-bit
(0..255) values.
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EasyHDR allows you to create a photo that covers a much wider dynamic range than a single
image  taken  with  a  typical  digital  camera.  First  of  all  you  have  to  acquire  enough  luminosity
information from the photographed scene. You can do that by taking several photographs at different
exposure times so the whole dynamic range is covered. The brightest details have to be clearly visible in
the  shortest  exposure  and  the  darkest  should  be  visible  in  the  longest  exposure  image.  It  is
recommended to set exposure times such that the Exposure Value (EV) step between the images is
about  1  or  2  EV.  In  most  cases  3  images  will  be  sufficient.  In  order  to  take  the  image sequence
automatically with your digital camera, you can use the Auto Exposure Bracketing (AEB) option.

For best results, the images shouldn't be too misaligned and therefore should be taken with a
camera on a tripod. However for easyHDR there is no problem if the photos were taken hand-held,
because it has automatic as well as manual alignment tools built-in. Both are able to compensate even
for perspective misalignment.

 3.2.  Image sequence loading

In order to load the image sequence just click New and multi-select all of the photo files. It is
also possible to add more photos to the already loaded sequence or to remove some of them without the
need to start again. If you load only one photo you will be able to enhance it with the tone mapping
operators that are normally used with HDR data. This feature is called "LDR enhancement" and simply
allows enhancing single shots – most preferably single RAW photos. EasyHDR will also load photos
dragged and dropped on the main program window or photos for which the paths are provided as run-
time  parameters  (useful  for  plugging  easyHDR  as  an  external  editor  for  other  image  editing  or
management software).

EasyHDR loads JPEG, JPEG 2000 (JP2 and J2K) photos as well as 8 and 16-bit TIFFs, PNG
and HEIF. It also features a built-in RAW converter (using LIBRAW and DCRAW) that is capable of
importing almost all of the RAW photo formats by all digital camera vendors. It is also possible to load
FITS file format,  that is most commonly used in astrophotography. EasyHDR supports additionally
High Dynamic Range formats:  Radiance RGBE (*.hdr), OpenEXR (*.exr) and 32-bit TIFF.

There is a possibility to resize photos on load (only RAWs and JPEG/JPEG2000). In order to be
able to use this feature please enable first:  Settings → Show options when loading photos in the main
menu.
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When the resizing is disabled, it is possible to load sequences of photos that slightly differ in
size. The size difference allowance can be defined in the Program Options → Miscellaneous. By default
the allowance is set to 0%, meaning that all input photos in the sequence have to have exactly the same
dimensions.

When the Color Management is enabled, the color space definition of the loaded photos is read
from their EXIF (all photos must be within the same color space). If the image is in certain color space
(other than sRGB), but it is not defined in EXIF, you can select that from the input color space list (see
chapter 9). In case of OpenEXR and RadianceRGBE formats, the space of the loaded image can be also
selected prior to loading (those formats may contain the space primaries as they do not have EXIF).

The RAWs, as the name suggest, are raw, not developed images. The output color space (result of the
development) can be selected in the RAW load dialog, sRGB is the default.

 3.2.1. Loading RAW photos

EasyHDR,  for  RAW  decoding,  uses  DCRAW  or  its  compatible  successor  –  LibRAW.  By
default LibRAW is selected, however it is possible to switch back to DCRAW by selecting it in the
Program Options → Miscellaneous. It is also possible to select there the demosaicing algorithm. By
default the best one is used – DCB.

EasyHDR provides a graphical interface to  LibRAW/DCRAW in a form of a dialog window
displayed when a RAW image is being loaded. 

You can select the target color space for the decoded image. The standard one is sRGB, but with
ProPhoto you will have a wider color gamut, which will help, while tone mapping, preserve details in
the most color-saturated areas. Please note that easyHDR’s color management module will make pixels
in any color space to be displayed correctly in the workspace. EasyHDR will also embed the image’s
color space definition into the output image file, so other applications can properly decode it. If you
want  the  final  result  to  be  used  by  a  non-color  space  aware  media,  you  should  select  automatic
conversion to sRGB when the result is saved.
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The  white  balance correction at  the  RAW decoding step is the best way to achieve greatest
possible  color  correction  quality.  It  is  because  the  operation  is  done on  raw data.  By default,  the
coefficients measured by the camera, at the time of taking the photograph are used (“as shot”). You can
also use automatic balancing method (will not work well in all possibilities, because it assumes the
image as a whole is neutral), or manually select the neutral point (the area that should be gray on the
developed image).  The neutral  point  selection can be done either for the decoding step (“LibRAW
selection” mode), or as a post-development tuning when “as shot” mode is selected. Then you can also
manually control the Temperature and Tint. 

In case of noise filtering, it's worth mentioning that the “Median filter” is useful for removing
hot pixels, while the “Wavelet filter” smooths random noise. Noise filtering is worth to be done when
loading a single or just a couple of RAWs for merging to HDR. When loading big number of lower
quality  RAWs for  stacking  (astrophotography)  the  noise  filtering  should  rather  be  off  or  kept  low
(wavelet) in order to preserve the details hidden in noise that will eventually pop after stacking.

The  “Other options” group contains two parameters that shouldn’t be used when processing
HDR sequences,  but  are  great  when working with single RAW photos.  The  “Recover highlights”
option allows getting more detail in the overexposed areas, but at the same time it may cause some color
shift  there.  “Auto  adjust  brightness” boosts  underexposed  photos.  The  other  two  parameters:
“Brightness” and “Contrast” allow fully manual correction to adjust the image, before it is touched by
the tone mapping algorithm.

If any further color correction is necessary or you want to remove some more noise, easyHDR
allows these at later steps as well – advanced color adjustment is possible at the tone mapping level,
while  more  noise  filtering  can  be  done  at  the  pre-processing  step  (in  the  HDR generation /  LDR
enhancement window).

RAW image loading.
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The  “Dark  frame” is  an  advanced  option  for  processing  of  long  exposure  photos  (useful
especially in astrophotography, but not solely). It allows removal of hot pixels – damaged pixels on the
sensor, which appear as blue, red or green points of various intensity on long exposure (or higher ISO)
photographs. They appear sooner at higher ambient temperatures. 

The “Flat frame” is another advanced option, which allows calibrating the image in terms of
removing uneven exposure of the frame caused by optical system vignetting as well as dust grains. If
you use this feature, please do not enable vignette correction in the “Lens correction” tool at later step. 

The near perfect hot pixel removal and flat field correction can be achieved only on raw images.
For example, if a long-exposed image with hot pixels is converted to JPEG (including when it’s  done
internally by the camera), the hot pixels are spread over larger area due to the demosaicing process and
also the JPEG compression causes its own artifacts. Such altered hot pixels are much harder to remove
and attempting to wipe them will surely cause other image details to be affected. 

A zoom in on a 20-sec exposure taken at low ISO, but at high ambient temperature with with Canon 650D. 
Some most notable hot pixels are marked with black circles. 

Some cameras offer an option to automatically remove hot pixels and long exposure noise. They
do it by catching the exposure twice – once with the sensor open to light and once when the sensor is
covered,  so  it  acquires  only  its  own noise.  That  approach  has  certain  advantages  –  each  photo  is
corrected  with  updated  dark  frame  (the  thermal  noise  level  varies  over  time)  and  the  camera  can
immediately save also corrected JPEGs. The drawback is that every long exposure needs to be followed
by another, with the same settings, so the “exposure time” is doubled. 
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Before and after dark frame subtraction.

When the camera is warmed up (its temperature is stabilized) and held in stable conditions, the
thermal noise level is quite stable as well (although there is the random component as well). The hot
pixels are stationary by definition and new ones appear very rarely. That allows simplifying the process,
by taking the dark frame image (same exposure with lens covered with lens cap) once every several
exposures. It saves time, but then you need to subtract the dark frame from images in software.

The existence of hot pixels spoils the photo, but if multiple, software-aligned, photos are merged
together, the hot pixels will appear as streaks of dots on the result (due to the alignment). Such streaks
are much more easily noticeable. It’s worth noting that applying the median filter is also a good way of
coping with salt & pepper like noise.

For more information on dark and flat frames please go to paragraph: 3.2.3.
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Dark and flat frame removal enabled using easyHDR-made master calibration frames.

If the imported RAW images look strange (completely bad colors etc.), it may mean that the
DCRAW or LIBRAW version used by easyHDR does not support your camera. Please make sure that
you use the current easyHDR version, if so please contact easyHDR support.

 3.2.2. Loading FITS photos

The FITS format import dialog is very similar to the one for RAWs. However, it does not allow
noise filtering of individual images. It also offers slightly different approach to contrast and brightness,
where the black and white points are set individually. 

You should keep the same contrast and gamma settings when loading multiple photos.

Both grayscale and color FITS are handled. The RAW color FITS (Bayer pattern) are not yet supported
by easyHDR.
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FITS load dialog.

 3.2.3. RAW and FITS calibration frames

Correction with a single dark and flat frame is possible, but due to random thermal noise on
these images, it will increase the noise level of the light image itself (the “light image” is the actual
photograph of the subject). It’s therefore a good idea to prepare so called master dark and flat frames,
which are stacks of multiple calibration images (10-20 should be sufficient). 

The master frame can be created either by clicking the “Make” button next to path of the dark or
flat frame in either RAW or FITS import dialog while importing the light images. It can also be made
earlier  by running the tool  from  “File→Make master calibration frame”.  It’s  enough to make the
master frames just once. When re-using the same calibration frames, instead of using the creation tool
please just provide the path to the master calibration frame that has already been created and stored in
TIFF format. For tidiness you should keep the separate frame sets in separate folders.
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The master calibration frame creation tool with a set of RAW flats loaded and output file name auto assigned.

The dark frames are exactly the same exposures as the light images (the same exposure time and
ISO), but with the lens cap blocking the light (that also means the lens can be removed and the camera’s
sensor just needs to be closed to light). 

The flat frames, on the other hand, need to be taken with exactly the same optical system as the
light images. The aperture must not be changed, nor the focus. You should also ensure not to clear the
sensor or let it get dusted, because the flat will not match the light image. To reduce the noise, you
should use low ISO and short exposure settings, meaning that the photographed flat object needs to be
bright. You should photograph something neutral in color and evenly illuminated, ensuring its out of
focus – like a computer or tablet screen held very close to the lens, displaying a white picture. The
exposure parameters should be selected in a way that the histogram is spanning around the two-thirds of
the scale. Taking good flat frames is sometimes not an easy task.

 3.3.  HDR generation

After loading the photo sequence, a “Generate HDR” window with processing options appears
automatically. If the EXIF data of the photos is correct and the calculated EVs (Exposure Values) for
the photos are good, you are just a click away from generating a HDR image. Otherwise you can go
back by closing the dialog and edit the EV values manually, or select one of the auto EV options in the
bottom of the  „Generate HDR” tab. The EVs are vital for correct HDR generation. They are most
important for ghost removal, but auto alignment also requires them to be more or less correct. If you are
going to process just one photo (LDR enhancement), you don't have to worry about EV at all. Those
values are needed just for proper image calibration.
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Setting the EV values for a 3-photo HDR photo sequence. 
The photos are automatically sorted by the EV values, from smallest to highest.

In the bottom of the „Generate HDR” tab you can find several options for automatic EV setup.
EasyHDR selects by itself the option that seems the best. The options are (from left to the right):

● EXIF:  available  when  the  EXIF  headers  contain  valid  data.  When  selected,  the  EVs  are
calculated based on exposure time, ISO and the f-number. 

● EXIF (AEB EV): available when there are EV bias values stored in EXIF (when photos are taken
with a camera in Auto Exposure Bracketing mode). When selected, the EV are not calculated,
but taken directly from EV bias fields in EXIF.

● Automatic (robot arm icon): easyHDR calculates the EV values automatically by comparing the
loaded photos. 

● Manual EV spacing: when a value is selected from the drop down menu, the photos are sorted
from darkest to the brightest and are assigned with EV values accordingly to selected spacing.

When AEB sequence of photos is taken, some cameras, sometimes store slightly wrong values
of exposure parameters. In such a case easyHDR may warn and automatically select the EXIF (AEB EV)
option.  If  you  developed  a  single  RAW  image  several  times  to  produce  two  or  more  differently
“exposed” images, the third party software might have transferred the same EXIF data to all output
images. In such a case you should either manually set the EVs, or select the Automatic option. When no
EXIF is available, easyHDR attempts to calculate the EV values automatically. 

You can experiment with HDR generation by disabling some of the already loaded input photos
from being used for the HDR. There is no need to remove the photos, just uncheck the checkbox next to
the name of the photo.
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HDR generation options.

The HDR generation step can be divided into two stages: 

1. Preprocessing. It includes lens correction and image alignment. By using the “Apply above and
crop manually” button, you can let easyHDR do the preprocessing and it will break, allowing
you to crop the image. Once you are finished, the “Generate HDR” window is shown again.

2. The actual HDR radiance map generation. It can be done using three available methods –
True HDR,  Smart Merge and Stack. Each of them has various additional options and features.
The HDR image generation is followed by noise filtering, so the already filtered image is used
for tone mapping.

 3.3.1. Preprocessing

Before  generating  the  HDR image  it  is  possible  to  preprocess  the  input  photographs.  The
available options are: lens correction and image alignment. After preprocessing, and closing the HDR
generation window, it is possible to view the modified photos in the main program window by using the
“Photo  before  processing” option  and  also  to  save  them with:  “File  → Save  preprocessed  input
photos”. Both transformations can be undone, allowing re-processing without the need to reload the
photos.
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 3.3.1.1. Lens correction

The camera lenses are not perfect (especially those cheaper). They have many optical defects,
among which there are  three  most  notable,  that  fortunately can be fixed with easyHDR. The Lens
Correction tool allows fixing distortion, vignetting and chromatic aberration. It can be used right after
the photos have been loaded, but before they are aligned or used for generating a HDR image. 

Lens distortion occurs when a lens is not projecting the light properly, by producing bent lines
on the camera's sensor from straight lines in the photographed scene. The defect is stronger in zoom
lenses and it varies with focal length. The fish eye lenses, because of their very short focal length,
characterize  with  very  strong  distortion.  This  however  shouldn't  be  considered  purely  as  a  defect,
because this is how the fish eye lenses work. With easyHDR it is still possible to straighten photos taken
with such lenses (using the crop/rotate/perspective/distortion tool), but it may make little sense to do it
fully, because it may require strong cropping,  or will introduce severe stretching of objects closer to
photo’s edges.

Chromatic aberration (CA) occurs when the lens does not focus all light wavelengths in one
point, because of different refractive index for different wavelengths, in different parts of the lens. In the
photo it appears as red-magenta and green-cyan “fringes” around dark-bright boundaries. This effect
gets stronger towards the borders of the photo and typically is the lowest (or does not exist at all) in the
center of the image. Cheaper lenses, especially the zoom lenses, have stronger chromatic aberration. As
it is with distortion, chromatic aberration also varies with focal length in case of zoom lenses.

Vignetting is caused by the lens not evenly distributing light over the image sensor and also due
to different angles of rays falling on pixels in different areas of the sensor. Compact cameras, with non-
replaceable lenses do the vignetting correction by themselves, because they know the characteristics, but
DSLR cameras not necessarily (especially if lens is not made by the camera’s manufacturer). 

The distortion and chromatic aberration vary with the focal length of the lens (if it’s a zoom
lens), but the vignetting varies also with aperture. Therefore if your HDR sequence of photos was taken
with varying aperture, each of the photos will be corrected with the same CA and distortion parameters,
but with different vignetting coefficients. 

When you store your photos in RAW format,  they are not corrected for distortion, CA and
vignetting.  Your  camera  may  not  do  it  either  (or  apply  just  partially)  even  when  saving  JPEGs.
Fortunately the corrections can be done in software and easyHDR is one of the options.
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Camera and lens were detected and found in the database. 
The tool is in the Advanced mode.

Camera and lens not detected, tool in simple,
manual mode.

The easyHDR’s Lens Correction tool uses the LensFun database of cameras and lenses in order
to  apply  correction  parameters  automatically  for  the  detected  camera-lens  pair.  If  the  required
information is not  found in photo's EXIF meta-data,  or the particular hardware is  not  found in the
database, the user can still set the values manually, or select the similar camera or lens from the list of
available models. Of course it is also possible to tweak the parameters if those from the database don't
give perfect  results.  There are several  numeric lens models  available.  For manual editing it's  much
easier to use those with less parameters:

1. Chromatic aberration correction

◦ linear, two parameters, easy to set manually

◦ polynomial, four parameters

2. Distortion correction

◦ PanoTools lens model, three parameters

◦ 3rd order polynomial, one parameter, very easy to set manually

◦ 5th order polynomial, two parameters

3. Vignetting

◦ “pa” model, three parameters

23/85

http://lensfun.sourceforge.net/
https://www.easyhdr.com/


        easyHDR 3.16 https://www.easyhdr.com/

The CA and distortion parameters are locked by default and the same are used for all of the
sequence photos. To force different parameters (normally not needed!), please just unlock the padlock
buttons. By definition, vignetting parameters are separate for each of the inputs. 

To help easyHDR auto find the right equipment, you can mark the owned models as favorites –
they will get better score. They are also marked with star icons and are easier to find in the drop down
lists.

When the “Search only in favorites and user” is checked, the auto detection (“automatic” lens
correction option in the HDR generation window) is done only within the models marked as favorite
and those created by the user. 

If LensFun does not come with definitions for your camera and lens, you can also create the
entries manually. Find a similar camera and lens and tweak the parameters, then create a new entry,
using the  “LensFun database → New from current settings” option. More advanced approach is to
manually edit the LensFun XML files – in such a case it is better to keep the own-created files in the
“User  LensFun  folder”,  so  they  won’t  be  lost  when  easyHDR is  updated.  After  editing  the  files
manually, please click the “Reload LensFun database” menu item.

Each user-created camera and lens pair is stored under a different file name. An already existing
definition is updated with new parameters, but if other aperture and focal length are defined, new entries
for those settings are appended. It is therefore possible to create definitions for the zoom lenses.

You can preview any of the input photos by selecting it from the drop down list in the top of the
window. The drop down also shows a tool tip with EXIF information for the selected photo. 

When manually  selecting  cameras  and lenses from the  lists,  you may find  the filter  option
handy. It  allows limiting to just favorites and user-created models and, in  case of lenses,  it  allows
filtering out all incompatible (with different mounts) and allows showing only those that fit a search
string. You may typically filter a certain focal length or the manufacturer’s name. 
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Defringe is a separate operation, that does not rely on the data from the LensFun database. It’s
job is to remove chromatic aberration fringes (red-magenta and green-cyan) around high contrast edges.
Those fringes may not necessarily be removable by the chromatic aberration correction feature, or the
LensFun database may not have the required parameters for the certain lens. For defringe, you can
control the strength and also the hue selectivity. The default hue suppress curve should work fine in
most of the cases, but sometimes some more attenuation of a bit more reddish, violet or blueish colors
may be needed to even better reduce the fringes. When the curve is straight in the top of the hue palette,
no color attenuation is done. Pushing the curve to the bottom, means attenuating the particular hue
range. Please watch out not to desaturate the pixels near the fringes too much, while tweaking the curve.

Photo before lens correction.
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Photo after lens correction – parameters taken automatically from the database. At this scale the most notable is the
distortion correction.

Zoom at photo before chromatic aberration correction. Zoom at photo after chromatic aberration correction.
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A zoomed in crop, close to the edge of a different photo
taken with an 18-200mm ultra zoom lens still shows strong

CA, even though CA correction using the LensFun
coefficients was applied. 

Defringing was applied to get rid of the red and green
fringes that are most notable on the high contrast edges.

Note: The Generate HDR window offers a possibility to use automatic lens correction. Before
using  this  feature  please  check,  using  the  manual  option,  whether  the  camera  and  lens  are
properly detected and that the correction parameters are good. It needs to be done only once for
particular camera and lens pair. There is no need to do that for all photos that you process.

Note: Please make sure that lens correction is applied to  a photo only once. For example if you
load to easyHDR JPEGs or TIFFs previously developed from RAW using other software, the
photo might have already been corrected. Also, some cameras may apply chromatic aberration
correction automatically.

Note: Defringing is a separate procedure. It may be applied in combination with lens correction,
or alone. It does not use parameters from the LensFun database.

EasyHDR remembers the last used Lens correction mode (whether it’s enabled and whether it’s
full  or  limited  to  just  distortion,  vignetting  or  CA correction).  It  stores  that  information  for  each
camera/lens/file format combination.

As mentioned before, the most challenging is correction of fisheye lenses. First of all it must be
noted that such correction may not be needed, or even anticipated in most cases, however in some it
might be possible and might give good results. In the sample below the trick was to move the center
point (drag with mouse) to the bottom-center of the image and set just one distortion parameter using
the simplest, 3rd degree polynomial model. You can also do it with the crop/rotate/distortion/perspective
tool available from the main window.

The noise filtering available in the “HDR Generation” window allows further fringe reduction.
It is achieved with the “Colors” parameter, which controls strength of color noise smoothing. The thin
fringes are within thresholds. 
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Photo taken with an 8 mm fisheye lens – no correction applied.

Center point moved to the bottom and the distortion parameter tweaked manually in a way to make the horizon
straight. The photo still requires some rotation, which can be done later (see “Image” in the main menu).
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 3.3.1.2. Alignment

In order to get the best, sharp and fine detailed results, the photo sequence used to generate the
HDR radiance map should be taken with a camera on a tripod. Of course it is not always possible. Even
the fastest cameras, with exposure bracketing option enabled, still need quite much time to take the full
sequence.  The  slightest  move  of  a  hand  during  that  process  can  cause  the  acquired  photos  to  be
misaligned in respect to each other, which results in artifacts on a generated HDR image. The weirdest
artifacts may appear on a HDR created with “True-HDR” method. They are caused by invalid pixel
luminosity – i.e. an area that should be darker on a shorter exposure is in fact brighter, which confuses
the algorithm.

Manual alignment 

EasyHDR has a built-in manual alignment tool that can be used to align the photos if it's needed.
The tool uses planar stretching method that is controlled (by the user) by manual placement of up to 4
pins for image pairs. One of the images, preselected by the user, is called “base”. All other photos (“to
align”) are aligned to the “base”. The user has to set the pins for each pair of the photos.

Crop of a tone mapped HDR blended from 
misaligned photos.

After manual alignment.

Below is  described  the  procedure  that  leads  to  generation  of  a  HDR radiance map from a
misaligned sequence of photographs is described:

● Load a sequence of photos into the program and click “Manual alignment” button in the “HDR
generation” window.

● Choose the base photo to which the remaining images shall be aligned. The base photo appears
in the top, left box. By default the middle exposed photo is automatically selected.

● Decide on the method of transformation (of course you can do it later as well, but please note
that the method is common for all photos that are transformed). Compensation for shift requires
setting of one pin pair. Shift and rotation needs 2 pin pairs. Perspective matching is achieved by
setting all the available, 4 pin pairs.
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Photo to be aligned is loaded into the top-right box. The preview style was selected as 
“difference” to better show the misalignment. Auto contrast ensures good calibration of both 

photos' brightness, so it's easier to compare them.

● Open one of the remaining photographs in the top, right box. This is the photo that will be
transformed by the program in order to be aligned to the base image.

● Set the pins, on the two loaded images (base and “photo to align”), so they point exactly at the
same object details of the photographed scene. It is a good practice to initially place the pins
close to the chosen scene features while the zoom is set to a small value and later fine tune the
placement at higher zoom. The pin centering option (see picture below) is useful while fine
tuning the positions. The view is automatically centered at the selected pin pair. 

The keyboard arrows can be used to fine tune the pin positions. Just double-click on the chosen
pin to enter the keyboard mode. While the right  Shift key is held, the pin jumps several times
faster. In order to exit the keyboard mode, press Enter, Space, Esc or double click on the image
away from a pin. 

Please note that the image is correctly transformed only after all the required pin pairs are
properly placed. You can disregard what is shown in the preview box until the last pin is
set and then use the preview while fine tuning.

● Repeat the operation described in the previous two points on every photo, that shall be aligned
to the base. Note that it is possible to set different pin positions for each image pair. 

● Click on the “Apply” button. The photos will be aligned and in the next step you will finally be
able to generate the HDR radiance map. 
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Four pins point at exactly the same picture features. The pins are set with sub-pixel accuracy.

The “auto contrast” option calibrates the brightness of both photos currently being aligned so
they  are  easier  to  compare.  Perfectly  aligned  photos,  perfectly  calibrated  should  produce  a  black
“Difference” preview image. In case of slight misalignment the “Difference” view shows bright borders
around edges. 

The manual alignment tool can be used in a semi-manual way. Right after the window appears it
is possible to use the “Auto all” button to allow easyHDR place the pins automatically. The user can
check whether the automatic algorithm succeeded and if it's necessary, correct the pin positions before
applying the alignment. The “Auto” button, on the other hand, causes automatic pin placement for just
the currently selected image pair.

When compensating for more than just the shift please note that the pins should be well spread
over the photograph. The best case is when they are located near the corners. Placing them too close to
each other or setting 3 or 4 of them in one line will result in big alignment errors and therefore should be
avoided. A score value (0 to 100) is calculated by the program to help you set the pins correctly. 

Bad spread of the pins. Pins are
almost in one line.

Score = 14/100

Bad spread of the pins. Pins are too
close to each other.

Score = 13/100

Good spread of the pins.
Score = 61/100
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In a HDR image sequence it might be hard to find the same details in both pictures (base and
“photo  to  align”)  due  to  the  difference  in  brightness.  If  the  detail  is  not  overexposed,  but  rather
underexposed in the darker of the photos, you may manually alter gamma setting for the particular
image, in order to brighten (or darken) it. “Auto contrast” option may also be useful. It automatically
enhances contrast (not gamma) in the darker of the photos, to match it to the brighter one.

Automatic cropping option can be used to cut off the parts of the images that are invalid in one
or more of the aligned photos. Such invalid parts have bad influence on the tone mapping process when
local operator is used.

Automatic alignment 

The  automatic  alignment  feature  is  a  convenient  way  to  align  photos  without  any  user
intervention. It always tries to compensate for shift, rotation, scale and perspective. 

Tip: you can check whether the alignment succeeded before generating the HDR image (which is time
consuming). To do so just close the HDR generation window and use the “Photo before processing”
option.

 3.3.2. HDR image generation options

The HDR generation step is the moment when the preprocessed, input sequence of photos is
finally merged, in order to form a single image – the HDR radiance map. It is possible to choose one out
of three methods for HDR generation: True-HDR, Smart Merge & Image Stacking.

EasyHDR allows also tone mapping of a single LDR photo (i.e. a single RAW or JPEG). In such
a case, a HDR radiance map is not generated of course. Instead, the input image is prepared for being
tone mapped. In easyHDR it is called “LDR enhancement”.

The common post HDR generation / LDR enhancement option is  noise filtering. This feature
reduces the noise level in the already generated HDR image, before it undergoes tone mapping. This
approach ensures that the noise itself is not strengthened so much by the Local Contrast tone mapping
operator. It allows relatively stronger local contrast boost, while preserving good signal-to-noise ratio in
the final photograph.
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Single RAW image tone mapped with high strength of Local Contrast operator. Without applying noise 
filtering before the tone mapping (left hand picture) the noise level is very high. If the noise filtering is 

applied, the image is smooth while the fine details are preserved. In this example the noise filtering 
strength was set at: 6 and softness was 3.

When processing an image which is an already assembled, 360° panorama, the “360°” option
should be checked. In this case the tone mapping will  be done as if the left  and right border were
connected  with  each  other.  Otherwise  they  wouldn't  match  when  virtual  tour  was  made  with  the
processed image.

 3.3.2.1. True HDR

The True HDR method generates a radiance map that closely represents the real light radiance
that was focused by the lens on the image sensor when the scene was photographed.  This method
requires proper Exposure Values set for the particular photos in the sequence.

When the HDR generation window is opened the program reads the appropriate exposure time,
ISO and f-number values from JPEG, TIFF or RAW EXIF headers and utilizes them to calculate the
true EV (Exposure Value). If there is no EXIF data embedded in the files, the photos are sorted from the
darkest to the brightest and the Exposure Values are set up to meet the spacing requirement. You can
also edit each of the EV independently. Note that these values are critical in HDR calculation process,
especially when you want to receive a realistic result. Learn more about the Exposure Value.

There are a couple of options available only for this algorithm:
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● Selectivity:  Controls  what  parts  of  the  input  photos  and  with  what  weight  are  taken  into
consideration  during  the  HDR image  creation  process.  The  “none” setting  means  that  the
importance of all pixels is equal. The “balanced” setting means smaller weight for under- and
over-exposures (weight gets smaller symmetrically towards black and white). “Cut off over and
under exposures” disregards just  the worst pixels,  while  “get  best  exposed” favors  brighter
pixels, where signal to noise ratio is higher, rather than darker pixels.

● Reject brightest and reject darkest: defines how many brightest and darkest pixels from the
entire  HDR  sequence  shall  be  rejected.  It  is  useful  only  when  averaging/merging  equally
exposed photos, when there are many of them, so typically for astrophotography stacking. It
allows rejecting pixels with satellite tracks, allowing to use the spoiled photos within the stack.

● Ghost removal: See below.

● Saving the HDR image: Check this option and choose the directory, the file name and format
(Radiance RGBE, OpenEXR or 32-bit floating point TIFF). Saving the HDR image (radiance
map) is possible only at this step.

Ghost removal

When the photos are well aligned some of the objects within the photographed scene may still
not match. These objects appear as ghosts in the final HDR image, because they are not in the same
position in all of the photos in a HDR sequence. In the “ghosted” area the input data for HDR image
calculation is improper and therefore has to be somehow fixed, otherwise ugly artifacts appear on the
final image.

A sample sequence of two differently exposed photos, where some subjects moved while the photos were taken.

Most common ghost sources are:

● moving people, cars, etc.,

● leaves or branches moving in the wind,

● fast moving clouds, smoke,

● ripples and waves on water,

● bad photo alignment,
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● misalignment that cannot be removed by aligning the photos – i.e. due to parallax.

Normally it should be avoided to take HDR sequences of scenes where ghosts might appear, but
it would severely limit usability of HDR techniques. Ghost removal tool in easyHDR allows to create
HDR photos even if some of the image area is ghosted. There is a manual as well as automatic ghost
removal possibility.

When the  “Generate HDR”  button is hit and the ghost removal option is checked, easyHDR
shows the ghost removal tool window. Of course, if the automatic alignment was also selected, it is
done first, so it may take a while before the de-ghost tool is shown. 

EasyHDR automatically attempts to find ghosts and if detected, they are immediately marked on the de-
ghost preview. 

Ghost removal tool – ghosts detected automatically.

Each mask color corresponds to the input image used for patching the painted area. The patching image
is carefully calibrated by easyHDR to match it best to the rest of the HDR. The areas not painted with
mask are created out of all input images.

The user is supposed to visually check the automatically created mask and if it's needed to modify it.
Helpful are three view modes:

● HDR before de-ghosting,

● HDR after applied de-ghosting – the current mask is used,

● Input photo – selected from a drop down menu.

The first two are just roughly, gamma-corrected HDR images. The view can be made brighter or darker
(to  show  various  areas  –  shadows  and  over-exposures)  by  changing  the  “Exposure” value.  This
parameter affects only the preview!

When the “Hide automatically” option is selected, the mask is shown only if the mouse cursor hovers
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over the preview.

If  the  automatic ghost  detection  did  not  work  good enough  it  is  possible  to  change  the  detection
threshold by tweaking the “Strength” parameter. The mask is auto regenerated. For the painted mask, it
is also possible to select the “Base photo” - it's a key frame used for the entire photo to patch all the
marked ghosts. Selecting  “Undefined” base photo allows easyHDR to auto-assign various inputs for
patching the ghosts.

The user can also paint the mask manually. The mask painting tool is either a brush of various sizes or a
flood-fill tool. The user can explicitly select which input photo to use for the particular mask that is
being painted. It is also possible to leave the decision to the program and use the  “Automatic” mask
type (default).  Mask type:  “Eraser” is  of course for clearing already painted masks. Eraser is also
enabled when painting with  Ctrl key pressed. The flood-fill tool can be used to change the particular
mask's target image, or to completely erase the selected, individual masked area. It cannot flood-fill a
not masked part of the photo.

Manually edited mask - red for -1,58 EV photo (currently selected mask type) and cyan for the other, 0 EV photo.
Longer exposure (cyan) is taken for the shadowed area, while the shorter exposure (red) is for the highlights.

As it was already mentioned before, the masked area is no longer a real HDR. It's just a well
calibrated patch of a single input photo. It means that the best results can be achieved when the ghosts
are relatively small and when the image that is selected for patching is well exposed (in the masked
area). Underexposed patch means high level of noise and possibly some brightness mismatch. In case of
overexposed patch the area will be overexposed in the final HDR image and additionally it will not
match in brightness.  The overexposed and underexposed areas are repaired (filled with best exposed
pixels, however not coming from the patch image) when  “Repair over and underexposed” option is
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checked. The “Smoothness” parameter controls the softness of the patch edges – smoother are better
blended and therefore less visible, but the patched areas are extended.

Tone mapped HDR image before (a) and after (b) manual ghost removal.

The ghost removal tool can be used to repair ghosted areas in your HDR photo, but because it is
possible to select which photo should be used for patching, there is yet another and very interesting
possibility. For example, it can be used to completely remove moving people or cars from a photograph.
It's just a matter of taking photos correctly. The ghost can be removed completely only if the affected
area is well exposed and without the moving object itself at least in one of the photos in a sequence (see
the example above).
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a), b) and c) Input photos (-2, 0 and +2 EV) – differently exposed, people moved while the sequence was taken,
d) tone mapped HDR – no ghost removal, e) ghosts removed, but in a way to leave the people as in the 0 EV shot (see
the red mask), f) the ghosted areas were patched in a way to completely remove the people (red mask replaces ghosts

with part of a 0 EV photo, while the green mask patches the area with +2 EV photo).
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 3.3.2.2. Smart Merge

This  method doesn't  generate  a  real  HDR radiance map.  Instead,  the  input  photographs are
merged together by taking the best exposed details with higher weight. The over and under exposed
areas are rejected. Ghost removal is not available here because the photos are not calibrated as it is done
for the True-HDR method.

The user can control the strength of Smart Merge's selectivity. In most cases the low values (0 –
2) are just perfect. In case of some photo sequences stronger effect may give some further dynamic
range compression, but sometimes it may cause unnatural look.

The result of the merge may look very natural when only slight local contrast enhancement is
used. Of course stronger tone mapping may also be applied in order to get more dramatic look.

a), b) and c) Differently exposed photos (photo sequence loaded to easyHDR), 
d) Result after Smart Merge, strength = 1, e) Result after Smart Merge, strength = 5 

(both results processed with default tone mapping settings).

 3.3.2.3. Image Stacking

Stacking is a method of blending photos by simply taking the average of the input images. The
luminance value for each pixel is a sum of the true signal and of course the noise. If the photographed
scene is static, the signal acquired for each pixel is constant for each photo taken at the same exposure
settings, while the noise is random. The average of the noise aims for a constant bias and thus is easy to
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subtract by a slight contrast boost. In other words by taking an average of photos the signal to noise ratio
(SNR) is increased. Also the dynamic range is expanded given the image quality improvement for the
darkest areas.

Top – part of a photo taken with Canon 650D at ISO1600 and exposure time 1 sec. 
Bottom – stack of 11 different exposures, taken with exactly the same camera settings, no other processing was applied.

You can also try to stack differently exposed photos instead of generating a HDR image. The
result will be characterized by improved dynamic range, but cannot be called a High Dynamic Range
radiance  map,  because  the  input  photos  are  not  calibrated  and  the  luminance  scale  is  untrue.
Nevertheless the result may be pleasing in some cases.

Note: Stacking is equivalent to merging equally exposed photos with the  “True HDR” method,
with “none” selectivity option selected.
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 3.3.3. Astrophotography stacking

Processing  of  astronomy  images  (deep  sky  astrophotography)  differs  a  bit  from  typical
terrestrial, daylight photography. The main difference is the very low light that is being captured. It
makes the effort very challenging. First of all the right equipment is needed – a tracker to guide the star
movement and a camera and lens able to capture enough light in reasonable time, with low enough
noise, not mentioning good atmospheric conditions, including low light pollution. 

Normal DSLR cameras need to be specially modified for astrophotography, by removing their built-in
IR filter. To fight with light pollution (if traveling to dark places is not always an option) it is possible to
use specialized filters – either those that can cut parts of the spectrum typical for light pollution (i.e.
UHC filter), or narrow band filters – like Ha, OIII, etc.

Instead of taking a single, very long exposure, it’s way better to take multiple images (the more
the better – easyHDR has limits though, it can handle up to 200 photos). The exposure settings – time
and ISO/gain, should be selected carefully not to exceed the limits of the tracker and the camera. Those
multiple images can be stacked together (averaged) in order to bring out much more detail. 

Some noise is residual and the vignetting of the optical system (and dust grains on the image
sensor)  do  cause  the  field  to  be  unevenly  exposed.  The  photos  should  be  therefore  calibrated  by
removing the dark and flat fields. EasyHDR can do both of that for RAW and for FITS images. It can
also create master (stacked) calibration frames. For more information please go to the paragraph: 3.2.3.

RAW import dialog – corrected white balance & brightness, also the dark and flat frames 
are used for image calibration. Astro-modified Canon 650D, Samyang 135mm f2 lens and UHC filter 

(therefore the remaining magenta-cyan color tone) – rural sky.
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FITS import dialog – corrected contrast and gamma, also the dark and flat frames 
are used for image calibration. Rosette nebula taken with black and white ZWO ASI 178MM, 

Samyang 135mm f2 at f4 and a Ha filter – city sky.

When loading RAWs please do rather not use the noise filtering in the import dialog, or use just
the median filter. Smothering too much there would cause the fine details to be lost. 

If some of your photos are spoiled by satellites or planes, use the “Reject brightest” option. It
will let you use those photos in the stack.

Typical settings for astrophotography stacking for RAWs. Please note the “Reject brightest”.
EasyHDR also does auto alignment of deep sky photos.
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Comparison of a single, developed RAW image taken with astro-modified Canon 650D and Samyang 135mm f2 lens at
30 sec of exposure and ISO 3200 with a result of stacking and tone mapping of 41 such photos. The exposures should

have actually be a bit longer, at lower ISO and there should have been at least 100 of them (alternatively, a better
camera and lens could be used...).

Multiple input images were spoiled by either satellites or even a plane flying directly through the center of the view –
here the frame with plane is shown for comparison. EasyHDR could still use those frames within the stack, by using the

brightest pixels rejection.
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4. Tone mapping 

When the HDR radiance map is generated, the next step is to tone map it, so it can be displayed
on  the  computer  screen,  saved  in  a  typical  image  format  or  printed.  Thanks  to  tone  mapping  the
dynamic range of the photographed scene is preserved and fitted into the capabilities of display media
(or storage formats). The resulting photo is in fact LDR (Low Dynamic Range), but it contains details
present in the whole dynamic range of the photographed scene. Therefore it is wrong to call the result a
HDR or either LDR image. It should be called a  tone mapped HDR radiance map. Tone mapping
does not only apply to the processing of HDR images. A digital camera applies tone mapping (with a
global operator – in this case a simple curve compression) in order to fit the acquired (i.e.) 12-bit image
pixel data into 8-bit per pixel (per channel) picture format. 

When the HDR image is generated in easyHDR the preview size is automatically adjusted so the
previewing process does not take too much time. After finding the best tone mapping settings just click
the “Process all” button.

EasyHDR allows you to save and load tone mapping settings.  It  also has a preset selection
feature, which allows faster access to most commonly used settings. To find out more about settings and
presets please go to paragraph 9.

 4.1. Global vs. local operator

There are 3 operator functions from which to choose. If the “Local contrast” and “Mask” check-
boxes are unchecked only the global operator is being applied. By checking the aforementioned options
the 2 available local operators can be enabled.

The global operator works the same for all pixels in the processed image, regardless on their
position. The result for each pixel is computed by using only the operator parameters set by the user and
the pixel's value. This ensures that there will be no brightness inversions in the output photo, leaving it
as  natural  as  it  is  possible,  while  fitting  the  selected  scene  dynamic  range  into  the  display  media
capabilities. No brightness inversions mean that the areas that were brighter than others in the real,
photographed scene, will remain brighter. This limitation makes it very difficult to compress the entire
dynamic range, without washing out colors or loosing local contrast. 

The local operator, on the other hand, is spatially variable. The local parameters are computed
for  each  pixel  independently  while  taking  its  neighboring  pixels  into  account.  Therefore  the  local
operator  is  capable  of  greater  contrast  reduction  on  wide  scale,  at  the  same  time  preserving  local
contrasts (details) and colors. When the effect is too strong, however, the photo may become unnatural.
It may sometimes be anticipated – to achieve a dramatic result, but also sometimes an unwanted “halo
effect” can show up.

The local operator works similarly to local, chemical adaptation in the human eye, which is one
of the factors that make the human vision capable of sensing very wide dynamic range. Note that in
classical digital photography only the global operators are used (i.e. gamma pre-processing inside a
digital camera).
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The parameters for the global operator in easyHDR are: 

● Compression, 

● Gamma,

● Contrast (histogram clipping),

● Color adjustment and color saturation (hue, white 
balance and selective saturation), 

● Tone curve (L, R, G and B channels). 

● 3d LUT color grading.

for the "Local Contrast": 

● Strength, 

● Highlights,

● Shadows,

● Blackness,

● Range,

● Micro,

● Details

and for the "Mask" local operator: 

● Highlights,

● Shadows.

 4.2. Global Operator: Compression, Gamma & Saturation

Gamma curve adjust is a function available in most image editing software. It  brightens or
darkens the photo, but at the same time it does not cause any image data to be lost, by clipping the pixel
values to black or white.  It  applies a  non-linear (gamma curve) transformation that compresses the
whole dynamic range of the processed photo. When the value is higher than 1.00 the pixel luminance in
shadows is amplified more than in the bright areas, therefore the compression is achieved. Setting the
values below 1.00 makes the photo darker and also the contrast gets stronger.

The  “Compression” function  applies  a  similar  non-linear  transformation  as  gamma  adjust.
However as opposed to the gamma function, it preserves and even increases the color saturation. See the
example below. 

Both parameters should be used together in order to get best results. In example, if the photo
gets too bright after the “Compression” is increased, it can be darkened with the “gamma” setting.
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a) Photo tone mapped with default settings (Gamma = 1.00, Compression = 1.00), b) Gamma = 1.80, 
c) Compression = 2.20, d) Gamma = 0.80, Compression = 2.20.

 4.3. Global Operator: Tone curve

Tone curve adjust is a powerful, but simple in use tool that is implemented in almost every
image editing software. It offers much more flexibility than the gamma setting described above. The
user manually shapes, using special knee points, the curve that is used to compress the dynamic range of
the photo. The points can be created by simply clicking in the curve area with the left mouse button.
Knee point removal is done by pressing the right mouse button while the cursor hovers over the selected
point. 
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The  curve  tool  that  is  implemented  in  easyHDR operates  on  HDR rather  than  LDR (Low
Dynamic Range) image data, as it is done in typical photo editing software. Because of that, operations
can have different, much better effects, i.e. brightening shadows does not necessarily mean boosting
noise level (of course there must be enough shadow information in the HDR composite). 

The curve tool does not make any changes to the output image when it is in the reset position
(straight line). It gives enough flexibility when there are 2 or 3 knee points.

EasyHDR allows editing curve either for pixel luminance or for each (red, green and blue)
channels separately. There is a set of several ready to use presets that can be the starting points to further
curve shaping – to access them just press the “star” button.

 4.4. Local Operator: Mask

The "Mask" operator works similarly to a gray filter mounted in front of CCD or CMOS device
during the exposure. The light coming from the photographed scene is focused on the surface of the
imaging sensor, but the filter attenuates it in certain regions more than in the other. The idea is similar to
using a gradient, gray filter mounted in front of the camera lens.

In case of HDR image processing, the High Dynamic Range radiance map that is recovered
from a sequence of photos is the estimated irradiation of the surface of the imaging sensor during the
exposure. EasyHDR calculates the complex gray filter mask based on the input HDR image and applies
the attenuation. The brighter, large-scale areas are attenuated stronger, than the shadows. Since the mask
does not affect the small-scale luminance variations, the local contrasts (details) are preserved – they are
not flattened.

A linear gradient gray filter may be enough in case of the simple scene as shown here. The two photos 
on the left are real single shots of the same scene taken with different exposure times. On the right side 

there is a simulated view as if the photo was taken with a gradient, gray filter. 

The  strength  of  the  mask  operator  is  controlled  with  the  "Highlights"  and  “Shadows”
parameters, selectively for the bright and dark parts of the image. Higher values  for highlights  mean
stronger attenuation of the bright areas  (they get darker).  Higher values for shadows mean that  the
darker areas are more strongly intensified (get brighter).
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In case of both photos: gamma = 1.00, compression = 1.80.
a) Highlights = 0.00, Shadows = 0.00, b) Highlights = 0.40, Shadows = 0.40.

 4.5. Local Operator: Local Contrast

This  operator  compresses  the  global  dynamic  range of  the  photograph while  enhancing  the
details at local level. It gives a lot of possibilities ranging from just slight improvement of contrasts (to
give  better  realism)  up  to  achieving  very  dramatic  results.  The  “local  contrast”  operator  is  very
sensitive, so when used with strong settings it may amplify noise, especially if the input images are of
low quality (i.e. taken with high ISO, with a poor digital camera, or saved with high JPEG compression
settings). In case of processing HDR image sequences please keep in mind that the noise level might be
lower if the HDR sequence of images covers the entire dynamic range of the scene – so if there are no
parts of the scene that are not properly exposed in any of the photos. Noise reduction is also achieved by
using “normal” selectivity in case of the True-HDR method. Even lower noise level should be possible
when using the Smart Merge method.

a) No local contrast applied, b) Local contrast applied 
By using the “local contrast” operator we achieve greater compression of the dynamic range of the 

photograph, while the details are not only preserved... they are enhanced.

The “Local Contrast” operator is controlled by a number of parameters. The “Strength” defines
the power of dynamic range compression and local contrast boost. The “Range” controls the extent of
the local detail sensing. The higher is the value the bigger areas of the photo are being treated as “local”.
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There is also a pair of parameters that control the brightness- and darkness- sensing thresholds of
the operator. The  “Highlights” setting defines how strong should be the contrast enhancement in the
brightest parts of the photograph. At the same time it little affects the darkest parts. The “Shadows” on
the other hand controls the level of dynamic range reduction in the dark areas. 

a) Strength = 0,50, highlights = 0.00, shadows = 0.30, b) Strength = 0.50, highlights = 0.60, shadows = 0.10.
By increasing the “highlights” parameter the clouds (which are the brightest in this photo) get more dramatic, 

while by decreasing the “shadows” setting the darkest areas are more strongly amplified.

If the signal to noise ratio in the darkest parts of the photograph (i.e. deep shadows or dark, night
sky) is too small, then it might be desirable not to enhance those parts so much because otherwise the
noise level would be unacceptable. Not enhancing the shadows too strongly could also preserve the feel
of realism. In order to achieve that please try increasing the “Shadows” value as well as “Blackness”,
which controls the threshold of shadow deepness. 

a) Blackness = 0,30, b) Blackness = 0,60.

Another  parameter,  “Micro”, controls  strength  of  the  smallest  details enhancement.  Similar
parameter -  “Details”, on the other hand, enhances the smallest details much more selectively, not
boosting noise on plain surfaces (like blue sky), but doing contrast boost just around most distinct edges.
It also does not introduce a halo effect. The “Details” works best in combination with high “Range”
values.

By using the “Mask” operator in combination with the “Local contrast” it is possible to further
boost brightness in the shadows and to attenuate the brightest parts of the image, while not bringing up
noise so much as it could be happening with the “local contrast” alone .
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 4.6. Black & white clip (contrast)

The human eye is not able to "see" the whole dynamic range of every scene, so if you want to
achieve a natural effect it is sometimes good to clip some shadows to black and some bright areas to
white. By loosing some information in those areas you get better a looking, more natural image with
better contrast. By default 0.1% of the darkest pixels are cut to black and the 0.2% of the brightest are
clipped to white. This makes the result look much more natural and not washed out, while sacrificing
only a small fraction of the dynamic range.

To set the clipping points just move the markers over the histogram or manually set the desired
cut-off pixel percentage, for black and white separately. There is also a possibility to set the clipping
points  by sampling the image with eyedropper  tools.  In  order to  use  the eyedroppers  click  on the
appropriate icon and then select the desired point on the image. Using left mouse button selects the point
from the currently viewed result image, while using the right mouse button chooses the point from the
input HDR image.

Example of the histogram clipping. The entire available dynamic range is preserved in the photo a), while in case 
of photo b) the 4,7% of darkest pixels are clipped to black and 1,8% of the brightest pixels are clipped 

to white. This means that there is a loss in dynamic range, but at the same time the photo has higher contrast. 
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If  the padlock icon is  “locked”,  the  clipping is  done automatically  to  the preset  percentage
values when other tone mapping parameters are changed. When it is in the “unlocked”   position, the
markers always stay in the same place, but you can still move them manually. 

When mouse cursor hovers above the histogram, two checkboxes are shown. When checked, the
under and/or overexposed areas are marked on the preview image with blue and red color. 

Marking the under and overexposed areas.

Click on the histogram to toggle the mode – right mouse button switches between RGB and
Luminance mode, while the left mouse button selects linear or logarithmic Y-axis.

 4.7. Color saturation

EasyHDR allows advanced control over color saturation. There is not only global saturation
setting, but there are also two selective tools:

● saturation selective by brightness,

● saturation selective by hue.

The small circles mark the currently pointed pixel on the brightness and the hue axes. The status bar 
shows the pixel value under the cursor.
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The horizontal axes have the meaning of brightness and hue respectively. When the curve is in
the middle of the gradient field (as depicted above), the saturation is not altered. Moving the curve up
means boosting saturation for the selected types of pixels, while lowering the curve means selective
decrease of saturation.

a) Saturation settings at reset position, b) Increased saturation for the blue color.

The user has control over the shape of the curve by the mean of control points. Each of them
defines a separate Gaussian function for which it is possible to set sigma (smoothness) parameter. If the
separate curves are close enough to each other, they are glued together, so it is possible to draw straight
lines. In order to add a new control point just click with the left mouse button on the tool. To remove a
point use the right mouse button.

One of the more advanced possibilities that the selective saturation gives is leaving just a single
color tone and making the rest of the photograph black and white. 

Saturation has been reduced to zero for all colors apart from red and violet.

52/85

https://www.easyhdr.com/


        easyHDR 3.16 https://www.easyhdr.com/

 4.8. Color adjustment

The camera  not  always  uses  the  perfect  white  balance settings  when the  photos  are  taken.
EasyHDR allows you to fix the color tone at the tone mapping step. Two settings fulfill  this task:
“Temperature” and “Tint”.  The first controls the blue-orange tone, while the second of them allows
green-magenta balance. The sliders offer fine-tuning mode, which can be enabled by clicking the zoom
buttons next to them. 

Sometimes the shadows and highlights require slightly different temperature and tint correction.
The “Balance” slider allows to tune the selectivity.

If there is a spot on the photo that should be neutral, you can sample it with the eyedropper tool.
EasyHDR will set the temperature and tint to fulfill the requirement. 

a) Tone mapped HDR created out of 5 photos that had some bluish tint due to bad white 
balancing done by the camera, b) white balance corrected automatically by sampling the marked spot.

The “Hue” setting, when used very delicately, can help with achieving best color temperature
correction. When tweaked more strongly it creates unreal effects by shifting the colors. That may be
useful if you want to achieve special coloring effects.
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 4.9. Vignette

Vignette tool can be used either to further reduce vignetting caused by camera lens (although it’s
better to do it using the Lens Correction tool), or to apply a creative vignetting effect. There are a couple
of parameters that give very wide range of possibilities:

● Amount – positive values mean dark vignetting, while negative cause brightening of the edges.
By setting the negative values,  the user is able to compensate for dark edges caused by the
camera lens. 

● Smoothness – the higher the value the smoother is the edge of the vignette.

● Size – distance from the middle point, to the edge of the vignette.

● Roundness – controls the shape. Value -1 means that the vignette is a rectangle with the aspect
ratio of the image, with the corners rounded a bit; 0 is an ellipse with aspect ratio of the image
and +1 is  a  circle.  When you are  fixing  the  vignetting  caused  by the  lens,  you should  set
roundness to 1.

a) No vignette applied, b) Vignette applied (Amount = 2, Smoothness = 1, Size = 0.75, Roundness = -0.75).

 4.10. 3d LUT – color grading

Apart from the described before,  standard color grading tools – like the RGBL tone curves,
saturation, hue, temperature and tint, easyHDR allows applying also predefined 3-dimensional color
Look-Up Tables (3d LUTs). The 3d LUT is a table that maps RGB colors (triples of R, G and B values)
into other RGB colors, allowing totally arbitrary change of color hue, tone, saturation, brightness, etc.
The color transformation depends only on input pixel’s RGB value and does not vary spatially.

The table cannot just map any possible combination of R, G and B values, especially for 16- or even
higher bit-depth of pixel values, because such a table would have to take a lot of memory. The colors
not defined in the table are therefore interpolated, but the LUTs are typically created in a way that
allows good interpolation results.
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 4.10.1 Importing 3d LUT files

EasyHDR is not an editor nor creator of 3d LUT files, it can only import and use such files (in
the *.cube format). Those files can be created with specialized software, or purchased from third parties.
There are also many freeware 3d LUTs available for download on the Internet. 

EasyHDR recognizes files that are copied to a special location:

● Windows: C:\Users\[name]\easyHDR 3\3dLUT-imports\,

● macOS: /Users/[name]/Documents/easyHDR3/3dLUT-imports/.

The files can be grouped in subfolders (one level of depth). 

In order to import the cube files you can just copy them manually to the above mentioned folder,
placing them in different subfolders or in the main directory. Alternatively you can use the “Import”
dialog (“Import” button in the 3d LUT selector toolbox).

The dialog allows creating and removing the subfolders as well as copying the cube files into the
selected subfolder, or removing the selected files. In order to create a group just type its name in the
“Subfolder” line edit and click “Create”. The already existing subfolders can be selected from the drop
down menu. The LUT files that exist in the selected subfolder are shown on the list. New files can be
added or the selected files can be removed. 

3d LUT file import dialog.

 4.10.2 Applying 3d LUTs

In order to apply a 3d LUT, the file has to be loaded. To do it, click on the leftmost button. The
LUT selector tool box will appear in the bottom of the workspace. 
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The LUT can be cleared by hitting the “X” button. It is also possible to apply the LUT with smaller
strength by controlling the opacity.

The LUT selection is stored in easyHDR presets. However, such a preset will work only if the LUT
file is present within the imports. That applies also to the project files – they do not contain the
LUT itself. 

The 3d LUT group in the tone mapping tab.

The LUT selector tool box shows thumbnails with the 3d LUTs applied. They are generated
when the selector is shown. If the base image changes significantly, when the tone mapping parameters
are altered, you may hit the “Refresh” button to re-generate the thumbnails.

To make searching simpler, it is possible to filter the shown thumbnails by typing part of the file
name, or by selecting a group (subfolder). 

The LUT selector tool box. 

The main window with the LUT selector bar shown. A selected LUT is applied.
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5. Layers

The normal approach is to process the whole photograph with single, user selected tone mapping
settings. Sometimes however you may want to process some parts differently – i.e. get more dramatic
sky, or make one shadow brighter, or even to change color of something, while not altering the rest. In
order to do so, you can process the photo several times (with different tone mapping settings) and later
blend those results with Photoshop or GIMP, masking the regions manually. EasyHDR brings layers
feature to give exactly this functionality, but with something more – live preview and possibility to set
tone mapping settings individually for each layer at any step of processing.

When a new project is started the layers are always disabled and the program allows processing
the whole image with just one set of tone mapping settings. In order to enable the layers, easyHDR must
be already in the tone mapping mode. Go to the main menu → Layers → Enable layers, or press the
"Layers" button in the tool box.

Layers enabled.

You can easily turn off the layers mode by selecting Layers → Disable layers, or pressing the
tool box icon again. The layers themselves are not removed and the settings are not lost, they are just
not applied to the final result nor the preview. 

 5.1. Managing layers

Initially, there are no layers. Just the "Base image" item is selectable. To create one, click the
"Add" button. The selection is immediately switched to that new layer item, which means that you can
already paint the mask on the image and that all the tone mapping settings visible in the right panel are
relevant to that layer. When a new layer is created, the current tone mapping settings are copied and
applied to it. There can be up to 9 layers, but please note that more of them mean more memory usage
and longer processing time.

The layer's global opacity is user-definable. In order to change it, hover with mouse over the
thumbnail – a slider is shown. When the mouse cursor is away from the item, the opacity value is
depicted with a thin bar just below the thumbnail.

57/85

https://www.easyhdr.com/


        easyHDR 3.16 https://www.easyhdr.com/

Layer opacity

Each layer can be individually enabled or disabled (see the check box next to the layers name).
It allows easy comparison of the result with and without the layer applied. If you feel it is helpful, the
layer's name can be changed. Just click on the name to edit it. More options are available in the item's
context menu. It is possible to invert the mask, clear it, or delete the selected layer. It is also allowed to
export and import the mask (in PNG file format), so that it can be edited using an external application,
or stored for later use.

Layer item context menu.

Switching between the active layers and the base image is done by just selecting the items. 

 5.2. Painting the mask

When any layer (other than the base) item is selected, the mask can be
painted on it. It can be done with either brush, paint bucket or interactive gradient
tool. There is also a separate eraser brush. Erasing can also be achieved with the
brush itself or with the paint bucket – the Ctrl/Cmd key must be held.

When the brush or the eraser brush is selected, you can choose its style. The
brush size changes automatically with image zoom factor, but there are also 4
different default size classes.

The slider next to the brush style drop down menu allows setting opacity of the
brush stroke.
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In case of both brush strokes the same brush style was used, but they were done at two different image zoom factors. 
The stroke to the left was painted at 10% zoom, while the one in the right when the zoom was 30%.

Mask painted with the intelligent brush. The painting was started in the spot marked with the cursor.
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There is a special mode of painting available.  When the  "Intelligent" option is selected, the
opacity of the brush depends on pixel values of the HDR image. The opacity is higher if the pixels under
the brush are more similar to values sampled when mouse button was clicked (the sampling point is
marked with a cross). It means that with long strokes you can limit to covering similar areas like for
example  the  sky.  The  slider  next  to  the  “Intelligent” option  allows  control  over  the  threshold  of
similarity. The intelligent painting mode is also available with the paint bucket tool (and actually only
then usage of this tool really makes sense). It works also with the eraser.

The  interactive  gradient  tool  gives  a  possibility  to  paint  image-wide  areas  with  a  smooth
gradient. The starting and ending points are set with a mouse on the image. There is also a possibility to
modify the gradient's middle point with the third pin. When the “Intelligent” mode is used, you can also
move the sampling point (marked with a cross). In order to apply the gradient just press Enter, or click
the button that appears in the top left corner of the workspace. For cancellation, hit Esc, or change the
painting mode. The Space key can be used to invert the gradient.

Gradient tool used to select the clouds, intelligent mode is enabled.

By default, the mask is visible as a green area over the background image, with 50% opacity.
The green color may sometimes be an obstacle, so there is a possibility to switch it to red, or blue. There
is also an option to show just the mask as a black and white image. The mask may finally be also made
invisible, which allows live preview while painting. The mask is automatically made invisible, when
mouse cursor hovers over the preset/history panel or the tone mapping panel.
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 5.3. Tone mapping settings

The tone mapping settings visible in the panel on the right hand side are switched accordingly to
selected layer item. Any change is applied to the selected layer only. When a preset is selected, it is also
applied to the currently selected layer. The only exception is vignette. For all the layers the vignette
settings are assumed the same as for the base image.

Any change of the tone mapping settings for each layer is stored on the history list. The changes
concerning layers are marked with "L[n]", where "[n]" is the layer number. When a new layer is created,
a "L[n]: START" record is added and it holds the initial settings. When a layer is deleted, the history
entries for it are removed. 

Example - the layer's mask was painted using the intelligent brush to cover just the sky. 
Then the layer's settings were changed to make the sky more dramatic and desaturated.

6. Image transformations

The image transformations (main menu: Image) can be done at any step – right after photos are
loaded, during tone mapping or post-processing. It is possible to rotate the photo by 90° left, or right,
rotate by 180° and flip it horizontally and vertically. There is also a combined, interactive crop, rotate,
distortion and perspective function. Rotation lets you fix tilted photos, distortion allows straightening
lines that should be straight and perspective gives even more freedom to visually correct composition,
(i.e. in case of architectural photography). 

When in cropping mode, an additional bar with options is shown. You can find there crop area
size with a possibility to block the aspect ratio, rotation angle, distortion and perspective factors. Those
values may be edited there, but they can also be set interactively on the image itself:
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• hold down Shift key and drag the image with mouse to set the rotation,

• hold down Ctrl/Cmd key and drag the image with mouse to tweak distortion,

• hold down Alt key and drag the image with mouse to set horizontal and vertical perspective.

The crop area can be resized by grabbing and moving markers on its edges and corners. To move it, just
drag it with mouse. A click away from the crop area starts new selection and a double click away (or
Esc key) abandons the cropping mode without applying any changes. To accept transformation click the
Apply button or double click inside of the crop area.

Image transformation options.

Note:  it  is  not  possible  to  undo  the  cropping  and free  transformation.  Please  also  note,  that
applying it several times causes degradation of image details. It's because of anti-aliasing filtering
applied. 

Photo corrected for distortion, perspective and rotation.
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7. Clone/healing tool

Whenever any small object spoils the photograph (like people standing in the distance, in a
landscape shot, or there is a dust particle on a sensor right in the middle of the clear blue sky), the
clone/healing tool can be used to remove it. The tool is a standard option in the typical photo editors, but
having it available at tone mapping stage in HDR processing software allows you to skip further post
processing and achieve perfect results using easyHDR alone. Also, not being distracted by the existence
of the rogue dust particles, you can find better tone mapping settings.

The clone/healing tool options.

The tool, as the name suggests, offers two options:

• Clone brush – copies the pixels directly from a different location,

• Healing brush – copies pixels from a different location, but at the same time applies color and
tone matching, in order to better fit the surroundings.

In order to start painting, you first need to mark the source position. You can do it by just clicking
mouse button with Ctrl/Cmd key pressed. Then, simply start the stroke over the object to erase. 

For both of the brushes it is possible to define the method of alignment:

• Not aligned – the source position is reset to the initial location, when each stroke begins,

• Aligned – the source is always equally separated from the destination, as it was when the first
stroke was started,

• Fixed – the source is stationary.

The base size of the brush, along with the smoothness and opacity can be controlled with sliders. The
size of the brush, as visible on the screen, stays the same while you zoom the image in and out, which
means it varies in respect to the image’s dimensions. 

The  clone  brush makes  direct  copying  of  the  pixels,  which  requires  the  source  and  the
destination  to  be  matched  in  terms  of  brightness  and  color,  otherwise  the  patch  will  be  clearly
distinguishable. In most cases it can be achieved by copying some nearby area, but this can cause visible
artifacts like doubled patterns (i.e. two or more same pebbles lying on the ground). Human brain easily
detects such unusual errors, therefore you need to try copying from various nearby areas.

The healing brush shouldn’t be used to copy and fix areas with large variations of brightness or
colors, like around distinct edges. However, it allows copying areas that look similarly and the object to
remove is relatively small as compared with the brush size. For example, you can copy the ground
pattern from a shadow and fix something in the sunlit part, or remove a small dust particle from the sky
using a larger brush.

When the object to erase is large and/or very different from the surroundings, you may try to roughly
“fix” it first with the clone brush, in order to flatten the area’s look. Then, do the final touches with the
healing brush, by copying patterns from various parts of the photo.
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The stairs have been removed with the healing brush, with the stones taken from the shadow.

The clone brush is not able to do anything good here with the source pixels taken from the shadow.

The clone tool is just the right choice when removing this road sign.
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Before repair.

After repair – removed: person, cable, road sign, bench, fences and the energy pole.

65/85

https://www.easyhdr.com/


        easyHDR 3.16 https://www.easyhdr.com/

The clone/healing tool can be used only at the tone mapping stage. When it’s enabled, changing
the  tone  mapping  parameters  is  disabled.  It’s  also  not  possible  to  draw layer  masks,  or  do  image
transformations. Every stroke can be undone by pressing the Undo button, or by pressing Ctrl+Z. The
Reset option undoes all the strokes made since the tool was enabled. When the tool is turned off, all the
changes are also lost. Pressing  Apply means accepting the changes, clearing up the undo queue and
closing the tool. Should you need to start again, just go back to the  HDR generation and start over
without the need of reloading (incl. lens correcting and aligning) the source photos. 

8. Post processing

If you are finished with tone mapping, you may do some post processing to the output image
before you save it. You can use 4 filters: Gaussian blur, sharpen, median and bilateral filter. EasyHDR
allows also manipulation of color tones.

After filtering is applied, it is possible to undo (in all cases excluding cropping). If you want to
reset all applied post processing you can simply go back to tone mapping step and reprocess the whole
image.

 8.1. Gaussian blur (smoothing)

You can use Gaussian blur filter to introduce some neat smoothing effect to your photo. The
higher the "Sigma" value the more blurred is the result. Use the "Opacity" setting to mix the blurred
result with the input.

a) Input photo: 8MPix, b) Sigma = 6.0, opacity = 100%, c) Sigma = 6.0, opacity = 50%.
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 8.2. Unsharp mask (sharpening)

The sharpening tool is a must in every image editing software. EasyHDR allows sharpening at
the tone mapping level, but also in the post processing step. You can change three parameters: "Sigma"
– extent; "Amount" – strength of the effect; "Threshold" – cutoff level.

a) Input photo, b) Sigma = 1.0, amount = 100%, threshold = 0.00, 
c) Sigma = 3.0, amount = 100%, threshold = 0.05.

 8.3. Median filter (noise reduction)

If you want to remove salt & pepper noise like hot pixels and you don't have a dark frame, this
filter will be just what you need. It scans the masked neighborhood of each pixel and exchanges the
luminance of the pixel with the computed, median (most probable) value. You can set the matching
threshold, so only pixels that are significantly different than their neighbors are affected. It causes the
noise to be wiped out while the other areas of the photo are left unchanged.

a) Input photo – Orion nebula, b) some dark bad pixels are easily removed with the median filter. 
Threshold: 0.12, horizontal bar – 5 pixels.
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 8.4. Bilateral filter (noise reduction)

The bilateral filter is a great noise removal tool that blurs noise while preserving edges. The
example below shows how the filter works. The low-scale areas similar in luminance are blurred, while
the significant edges are not affected.

Apart from "Opacity", the user can control "Sigma" – extent of blurring and "Threshold" –
edge detection level.

a) Input photo, b) Sigma = 2.0, opacity = 100%, threshold = 0.5, 
c)  Sigma = 4.0, opacity = 100%, threshold = 1.0.

 8.5. Sample/target balance

This tool allows to change sampled color tones into target colors (set by the user). For greater
flexibility you can apply changes to shadows, highlights or middle tones separately. Additionally you
can limit the strength of the color transformation by lowering the "Opacity".
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You can set the target color by clicking the left mouse button on the appropriate field. Click on
the sample to reset the target color. If the target color is the same as sample the tool has no effect.

9. Color management

EasyHDR  can  properly  work  with  color  managed  photos  and  monitor  profiles.  The  Color
Management is disabled by default (when the program is installed), but can be enabled by checking the
option in the main menu: Color Settings → Color Management.

Color Management options – in the main menu as well as the status bar.

The photograph's color space is extracted automatically from the JPEG or TIFF input once the
image file is loaded. In case of RAWs, RadianceRGBE and OpenEXR the color space is user-defined at
loading. If the color space definition is not embedded it is always possible to manually select the space
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from a list (sRGB, AdobeRGB, WideGamut or ProPhoto). The monitor color profile can be selected
from one of standard profiles (sRGB, AdobeRGB, AppleRGB, ColorMatch, or DCI-P3) or loaded from
an ICC or ICM file.

The color transform function that is calculated basing on the input and output profiles is used to
properly display the image colors in the program's preview window. The color space of the output photo
is not changed and is the same as it is in case of the inputs. The color space definition is just rewritten to
the output photo, so other color management aware software can display it properly.

Raw photos, by definition, do not have any color space. When they are loaded, the image data is
decoded into a user-defined RGB color space. 

EasyHDR can work  only with  RGB color  spaces.  Other,  like  for  example:  CMYK are  not
possible to use. Note that all input photos (that are used to create one HDR image) have to be in the
same color space, otherwise easyHDR will deny to load them.

For best quality process only 16-bit, color managed TIFFs.

10. Batch processing

If  you want  to  process many image sequences,  especially  if  the photos are  very big,  you'll
appreciate the advantages of batch processing. The idea is to create a list of many tasks to be done by
easyHDR and then let the program do the whole job without user  interaction. Below you can see the
batch processing window (click File → Batch processing).

The first step is to create a list of tasks (1). To do so use “Auto create tasks” option to make
tasks automatically out of files from within a defined directory. There is also a possibility to add a single
task by directly pointing a HDR image sequence (or a single image for LDR enhancement). 

The tasks (2) are displayed in a scroll box. Each of them is a separate processing job for easyHDR and
has own settings associated (3). Every task has a name that is used as the output file name. The input
photos' names are also displayed along with the thumbnails. To change the task name simply click on it.
The settings are displayed for all selected tasks. If at least one of them has different settings, a warning
message is shown:

You can apply then the currently visible settings to all selected tasks. 

If there are various types of tasks selected at once (both HDR sequences and single photos) always the
settings for HDR processing are displayed. Of course some of the options are not valid for single-photo
tasks  in  this  case.  If  tasks  consisting  of  only  single  photos  are  selected,  then  appropriate  set  of
parameters is visible, as depicted in the picture below.
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The main batch processing configuration window.

Settings for single-photo tasks.

There are three possible options for tone mapping settings usage. You can select any settings file
(*.ehsx) from your hard drive, you can choose a single preset from drop down list, or finally, you can
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select a set of available presets. In the latter case, tasks are processed several times, for each selected
settings. The preset name is appended to the output file name. This option is perfect if you want to
compare results achieved with several settings and just choose those which you prefer.

The task list can be saved and loaded later. There is an option to process only tasks that were not
completed previously, so it's possible to continue the once stopped job, even after system restart. It's just
important not to change the input photos location on the disk and not to delete or remove the already
done results.

If the automatic task creator failed to combine some of the photos into tasks correctly, you may
fix it manually. Each multi-image task can be split into single-image tasks. Any set of selected tasks can
be combined together. These options are available in task's context menu (right click).

Configuration common for the whole batch job is available after switching to the “Options” tab (4). 

Options common to the whole batch job.

The options are: 

● Color space for the imported RAW and HDR images,

● More LibRAW/DCRAW options for RAW import: white balance, noise filtering and highlights
recovery,

● Destination folder – by default each task is saved in the same folder as the input photos, but it
can be a different, user specified location,

● Result file format – TIFF, JPEG/JPEG2000. Optionally, also the easyHDR project can be stored
in EHPX format. It is also possible to turn off the tone mapping here, allowing to generate and
store just the HDR radiance maps in *.hdr or *.exr formats (see in HDR generation options).

When everything is ready, you can finally start the batch job. It's possible to run all the tasks, or just 
those selected. There is also an option to shutdown the system on completion. When you use it, please 
make sure that all of your open documents are saved, or better, that all other applications are 
closed. This will prevent data loss.
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 10.1. Automatic task list creation

The power of batch processing is handling tens or hundreds of tasks. It wouldn't make much
sense  if  tasks  had  to  be  created  manually  one  by  one.  EasyHDR  is  able  to  create  the  task  list
automatically.

It is possible to add tasks built out of files from within a single directory. The current list is appended,
not  cleared  first,  so  this  feature  can  be  used  several  times  for  different  inputs.  By default  a  fully
automatic method of HDR image sequence detection is in effect. In this mode, the EXIF headers of all
the image files found in the defined directory are examined by easyHDR. The photos that were taken
within a very short period of time are assumed to be in a single HDR sequence. If you always take your
HDR sequences using AEB mode in your camera, you should also select “AEB sequences only” option.
It raises the accuracy because photos taken in continuous shooting mode (but not AEB) or those taken
fast one after another are not merged together into single tasks.

Automatic task creation options.

Another method assumes a fixed amount of photos in each HDR sequence, in the source folder. There is
also a simple mode useful when you want to process single photos only (LDR enhancement). Each task
consists then out of a single photo.

11. Tone mapping settings management, presets

EasyHDR allows you to save the tone mapping settings to files and to import those settings later.
The most  commonly used settings can be put  into a  special  pool  of presets.  When the program is
installed, a couple of built-in presets are already there – i.e. “dramatic-bright” or “natural”. 
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By  grabbing  and  moving  the  edge  of  the  panel  you  are  able  to  resize  the  thumbnails.
Additionally,  when  the  panel  gets  wider,  the  view changes  and  the  presets  are  displayed  in  more
columns.

In order to add a new, user preset (based on the currently selected tone mapping settings) you
can use the “plus” button in the top-right corner of the panel. You can rename user presets by simply
clicking on the names. To replace a preset with current settings or delete it, just click right mouse button
on the thumbnail to open a pop-up menu with options.

The presets are just ordinary easyHDR settings files (*.ehsx). What makes them different is the place
where they are stored:

● Win XP: C:\Documents and Settings\[name]\easyHDR 3\presets\,

● Windows: C:\Users\[name]\easyHDR 3\presets\,

● macOS: /Users/[name]/Documents/easyHDR3/presets.

The built-in presets are in the easyHDR appliaction folder:

● Windows: C:\Program Files\easyHDR 3\built-in presets, 

● macOS: symbolic link - /Users/[name]/Documents/easyHDR3/built-in presets.

The  user  presets  can  be  grouped  into  user-defined
folders. Group selection is possible only when user presets are
filtered (third button from the left). To move an existing preset
from one group to another just right click on it and choose the
target.

Management  is  done  with:  Settings  → Setup  user  preset
groups. Using the dialog, you can create or remove the groups.
Renaming is possible after double clicking on an existing group
name.  When removing a group that contains presets you can
choose either to delete, or to keep them as “not grouped”.

The user groups are just  sub-folders  in the  easyHDR
3/presets location on your hard disk, which means it's very easy
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to  manage  all  the  user  presets  manually  using  Explorer  (Windows)  or  Finder  (Mac).  Please  note
however, that after manipulating files and folders there, you have to restart easyHDR, so it can refresh
it's own lists. The simplicity of user preset handling adds another advantage -  you can easily back up or
move your presets from one PC to another, or even share them with other people.

12. Saving the result

EasyHDR can save the results in TIFF, JPEG and JPEG 2000 image formats. It is also possible
to save the generated HDR radiance map as Radiance RGBE (*.hdr) or OpenEXR (*.exr). However it is
only allowed in the "HDR generation" window, for the True-HDR method.

The difference between TIFF and JPEG format is that the first of them is loss-less (even if the data is
compressed). It means that absolutely no detail is lost when the file is saved. The  LZW compression
works well with 8-bit TIFFs, but for 16-bit data the  Deflate method produces, in most cases, smaller
files. For best quality you should save in 16-bit TIFF format, especially if you want to do further post
processing with other photo editing tools.

The less popular format, JPEG 2000 (JP2), allows both lossy and lossless compression of 8 and 16 bit
data. The lossless compression is done when the quality is set to 100.

When saving in JPEG format it is additionally possible to resize the photo. You can define the longer
edge of the photo in pixels. 

EasyHDR is capable of transferring EXIF headers to the output photographs. It uses an external
Exiftool software to achieve this goal. Exiftool is capable of transferring full EXIF data from and to all
image formats including RAW photos.  If  your camera  stores location information, but you want to
remove it from the particular photograph, you may easily do so by un-checking the “Keep geolocation”
box. It's perfect option if you want to share the photos on the Internet, but you don't want to show
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everybody the exact location where they were taken (eg. in your backyard).

When color management is enabled, it is possible to convert the color space of the photo to sRGB. It is
useful if photos in other color space were processed and you want the results to be displayed correctly
by programs that do not support color management, also when you want to publish them on a web page.

The DPI value definition is for user's convenience. It does not influence the pixel dimensions, or amount
of detail. It is just a value that in addition to pixel dimensions defines the physical dimensions of the
photo. It is useful to set it to a value that you normally use when preparing for printing, because then
you can more easily edit the physical dimensions of the photo when post-processing in an external
application.  The  most  commonly  used  value  is  300,  it  ensures  very  good  print  quality  (invisible
pixelization).

Physical dimension [mm]= Pixel dimension
DPI

⋅25.4

Pixel dimension=
Physical dimension[mm]⋅DPI

25.4

In case of DPI resolution = 300, the pixel dimensions for a 15x10 cm print are: 1772 x 1181 (just 2
megapixels). An 18 megapixel photo can be printed on a ca. 44 x 29 cm paper.

 12.1. Exporting to external editor

If you want to do further processing on the photo generated with easyHDR you can use the
export to external editor option instead of saving to file and manually opening it with the other software.
Before this option can be used it must be configured in the Program Options. You have to provide a path
to executable of the third party software you want to use.

Configuration of the external editor.

Export to external editor allows transfer of 8 or 16 bit pixel format. It is user selectable, because not all
image editing software support 16 bit photos. It is also possible to select whether conversion to sRGB is
needed, or the color space should remain the same.
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13. Saving and restoring projects

EasyHDR provides a way to save and restore your work. The project file can be saved and
loaded using actions from the “File” menu. The project contains the following items:

● Preprocessed input images (aligned and with Chromatic Aberration corrected), along with full
EXIF data, color profiles and EV values,

● HDR generation settings,

● Ghost removal mask (if set),

● Generated HDR image (optionally),

● Layer masks,

● Tone mapping settings for each layer.

When the project file is loaded, the photo can not only be tone mapped again, but also the HDR
image may be regenerated, with different settings and different ghost mask.

The project file can be very big, especially when the HDR image is embedded. Putting HDR image data
into the file makes sense only if you rather do not plan to regenerate HDR and at the same time want to
load the file a bit faster.

When the HDR data is embedded in the project file, it is optionally possible not to embed the input
photos. It allows significant project file size reduction, but makes it impossible to fully reedit the photo
when the project  is  loaded (ghost  removal,  lens correction,  alignment and HDR generation are not
available). It is only possible to modify the tone mapping.

14. Program options

Most of the program settings are saved automatically when the program is closed (eg. image
saving options).  There are several  options however that  are set manually.  In order to modify these
settings click Settings → Program options. 
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Program Options window.

Appearance

By default, easyHDR has a dark gray skin. You can change it here to light gray one. Another two
options (“scale” and “pixel ratio”) allow scaling of all program fonts, buttons and windows. Normally
the program takes the system's DPI setting to scale itself, but with the options here you can override the
system's values. 

Dark and bright gray skins.

The  “High DPI” option is  available only if  your desktop supports  it  (4K screens).  When enabled,
easyHDR works in full resolution mode, which means that all the icons, fonts, tools and workspaces
look  much  sharper.  There  is  one  disadvantage  however.  The  program  has  to  do  4  times  more
calculations to show the live tone mapping preview. If it causes inconvenience, please enable the live
preview resampling (it can be found in the Performance tab).

Any change of the appearance settings requires easyHDR to be restarted.
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Scratch pad memory

You can choose here which hard drive (or directory) should be used by easyHDR to store temporary
data. The option is set to system temporary directory by default. This setting should be modified only if
you have little free space on the hard drive where the operating system is installed. The necessary free
space for the program to work properly depends on how big images you want to load into the program
and how many of them are in sequences you blend into HDR. The data is dumped to the disk only if it
cannot be stored in memory. It's good to have at least 1 GB of free space.

User data

This option allows you to change the user folder location, if for any reason the standard location is not
welcome. One case may be macOS folder access restrictions – you may not want to grant easyHDR
access rights to the User Documents location.

Performance

EasyHDR is capable of using several CPU cores, if they are available. By doing parallel processing the
performance of the program is greatly improved. It is possible to select the maximal number of cores
used by the program in normal or in the batch mode separately. Note that when the maximal number of
cores to be used is the same as available number of cores, easyHDR will claim 100% of CPU time
during some operations. That means that other processes running on your system will work much slower
during that period of time. 

There are also other performance settings. When live anti-aliasing is enabled the photos are anti-aliased
while zooming and panning, otherwise a rough image is displayed and after  some timeout an anti-
aliased view appears. The live tone mapping mode means that the tone mapping preview is generated at
the same time as the settings change, otherwise a timeout must pass before the view is refreshed. Live
tone mapping while zooming and panning does not require any further explanation.

There is also a special option that allows live tone mapping of a re-sampled image preview instead of
full resolution one. The full resolution image is calculated after a short timeout passes. This feature may
be really useful on slow computers, or when the screen resolution is very high – then the preview area
that needs to be reprocessed live is large and requires more processing time (especially when working
on a high DPI screen).

External editor

See the “Exporting to external editor” section in this document.

New project

● Auto generate HDR / preprocess for LDR enhancement

If  you  repeatedly  use  the  same  HDR generation  settings,  you  may  enable  automatic  HDR
generation (or preprocessing for LDR) that will be done immediately after photos are loaded.
Optionally, you can also select to automatically apply ghost removal. The option may be limited
to easyHDR operation as the Lightroom’s plug-in.
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● Reset color adjustment settings for new project

When enabled, the Color Adjustment settings (temperature and tint) are reset for new projects.

● Automatically show file open dialog when starting new project

It is enabled by default. Disabling it is useful when you want to load photos mostly by dropping
them on the workspace instead of using the “New” or “Add” buttons.

Saving result 

Here it is possible to define the default output file name. It is set up in a form of expression with tags
(see the tooltip for the line entry to see the details):

• %F – is a list of file names separated with “_” characters,

• %C – common part of the input file names,

• %L – list of uncommon parts of the input file names, separated with “_” characters,

• %0 – middle exposed (0 EV) photo file name,

• %N – number of input photos,

• %E – input file extension (format),

• %P – name, preceded with “-” character, of the current preset in use (if it was not edited by
changing any of the tone mapping settings).

The %C+%L or  %F alone is  required  to  be  part  of  the  expression.  By default,  the  expression  is:
%C%L_easyHDR%P,

For example, when the input photo file names are: IMG1234.jpg, IMG1235.jpg and IMG1236.jpg, and
the  “natural”  preset  is  used,  the  default expression  results  in  the  following  suggested  file  name:

IMG1234_5_6_easyHDR-natural.

In this tab, you can also choose whether the output folder shall be the same as the folder of the source
photos, or shall it be as the last that was used for saving. 

Another option lets you decide whether you want the exposure time values be removed from EXIF in
case of HDR images. Normally the exposure time makes no sense in case of a HDR, but you can have
the value taken from the 0 EV photo, when the removal option is turned off. 

It is also possible to define the default HDR image format: Radiance RGBE, OpenEXR or 32-bit TIFF.
This setting is used in the HDR generation window and in the batch processing to define the (optional)
HDR image output  format.  The “Normalize”  checkbox enables  normalization  (scaling  pixel  values
down to 0..1 range) of the HDR data for the file – needed by some third party software.

Finally, you can define the default description added to the EXIF of the result image (can be edited on
saving) and the “Artist” field in EXIF (leave it blank to preserve the value already existing in the input
images).

Other result saving parameters are stored automatically when the program is closed (i.e. the last used
file format, JPEG quality or TIFF compression).
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User logo

You can define here your logo/watermark/signature image (in PNG format) that may be added to the
result photos. You will be able to enable or disable the logo and define its location each time the result
is saved. The margin and logo scaling need however to be set in the Program Options.

Miscellaneous

Some other options are available here:

● Raw decoder

Choose between DCRAW and LibRAW (default).

● Raw demosaic interpolation algorithm

Selects the algorithm used by DCRAW/LibRAW to demosaic the Bayer pattern. The best one
(and most time consuming) is DCB – it reduces the color moire and aliasing effects the most. It
is also the default one. 

● Allow input photos to differ in size

Percentage-defined allowance of size difference between the photos in a single HDR sequence.
When set to 0% (default) the input HDR sequence photos must have exactly the same pixel
dimensions. If you want to load photos that are slightly and differently cropped due to some
external preprocessing, please define the allowance. 

● Detect panorama by aspect ratio and set suitable HDR generation settings

When checked and when a photo with aspect ratio 2:1 is loaded, easyHDR shows a question
dialog asking whether to override some of the last used HDR generation settings with options
suitable for panorama processing – it enables the 360° option and turns off the lens correction.

● Require Ctrl/Cmd key pressed to zoom with mouse wheel

By default this option is turned off. In this case zooming the image can be done with mouse
wheel. When it's on, mouse wheel is used to scroll the image (up/down and left/right), zooming
requires Ctrl (Windows), or Cmd (Mac OS) key to be held. 

● Use system native open/save file dialogs

When selected (default), the file dialogs shown by easyHDR are standard system file browsers.
Turning off this function makes the Qt framework's dialogs to be shown instead. The latter do
not show thumbnails. This option is supposed to changed only if there are problems with the
native dialogs.

15. Adobe Lightroom plug-in

The plug-in allows exporting photos from Adobe Lightroom (version 3 and higher) to easyHDR.
After processing, the results are automatically imported into the Lightroom Catalog.
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 15.1. Installation and setup

Install easyHDR 3 demo if you want to try,  or the full  version if you are a registered user.
During installation on Windows please make sure that Lightroom plug-in option is selected. It is by
default if Lightroom is detected in the system. When easyHDR is installed on Mac OS, the plug-in is
installed automatically – if Lightroom is already installed.

Lightroom plug-in Manager

The plug-in files  are installed in:  C:\Users\[name]\AppData\Roaming\Adobe\Lightroom\Modules\ on
Windows,  or  in  /Users/[name]/Library/Application  Support/Adobe/Lightroom/Modules, or
/Library/Application Support/Adobe/Lightroom/Modules on macOS. It automatically becomes available
to Lightroom, you may just need to enable it in the "Plug-in manager".

 15.2. Plug-in usage

In Lightroom, select photos you want to process with the plug-in. Then go to File → Export and
choose “Export to”: “easyHDR 3”. An export options panel will show up. Depending on the mode you
want to use, you should select a single image, several photos supposed to be merged to HDR, or a set of
photos you want to process separately. 

The plug-in's export options are divided into several groups:

1. Export Method: Selection of the mode of operation for the plug-in:

● Manually edit the photos with easyHDR 3 – the selected photo or a sequence of photos
(to be merged to HDR) is loaded into easyHDR. You are responsible for processing and
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saving the result manually. Once you save the processed image, just exit easyHDR. The
image is automatically imported to the Lightroom catalog.

● Process with easyHDR 3 in background – the selected photo or a sequence of photos (to
be merged to HDR) is loaded into easyHDR, automatically processed using the provided
settings, saved and finally is imported into the Lightroom catalog. EasyHDR program
window is visible during the process but cannot be used by the user.

● Process with easyHDR 3 in background, each selected photo separately  – each of the
photos selected in Lightroom is loaded into easyHDR separately, one by one. No HDR
image is generated – each photo is processed as LDR. All generated results are imported
into Lightroom catalog.

2. EasyHDR 3 Processing Options – here you are supposed to define the settings for easyHDR,
like image alignment, ghost removal, noise filtering, tone mapping preset and the output file
format.

3. File Settings – This is a standard Lightroom panel. It allows defining the exported image format
(the format of the image that is loaded by easyHDR, not the format of the result!). If you choose
“Original”, the exported photos are not altered before they are loaded into easyHDR, otherwise
they are re-formatted using the provided settings. Only TIFF format is allowed here because it
makes no sense to loose quality while converting to JPEG. The common cases when you want to
change the exported image format are:

● You want to process RAW images, but you want Lightroom to do RAW conversion
instead of leaving it to easyHDR.

● You want to resize the image before exporting it to easyHDR (see point 4).

● You want to remove some metadata from the exported images before they are exported
(see point 5).

● You want to change (or set, in case of RAWs) the color space before the photos are
loaded by easyHDR.

● EasyHDR does not support the image format you want to export.

4. Image Sizing – It's available only if format conversion to TIFF is selected. It allows resizing of
the images before they are exported to easyHDR. 

5. Metadata – It's available only if format conversion to TIFF is selected. It allows removal of
some EXIF headers – like location information etc. before the images are exported to easyHDR.
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Export options dialog.

It's very useful to create own Lightroom presets, based on defined export settings. You have then very
easy access to the most commonly used setups. There are two such presets installed along with the plug-
in. They are available by right-clicking on the image and selecting “Export” from the popup menu, or
from File → Export with preset.

84/85

https://www.easyhdr.com/


        easyHDR 3.16 https://www.easyhdr.com/

85/85

https://www.easyhdr.com/

	1. Introduction
	2. User interface
	2.1. Workspace
	2.2. Main tabbed panel
	2.3. Additional tone mapping options panel
	2.4. High DPI support

	3. HDR radiance map generation
	3.1. Taking the photographs
	3.2. Image sequence loading
	3.2.1. Loading RAW photos
	3.2.2. Loading FITS photos
	3.2.3. RAW and FITS calibration frames

	3.3. HDR generation
	3.3.1. Preprocessing
	3.3.1.1. Lens correction
	3.3.1.2. Alignment

	3.3.2. HDR image generation options
	3.3.2.1. True HDR
	3.3.2.2. Smart Merge
	3.3.2.3. Image Stacking

	3.3.3. Astrophotography stacking


	4. Tone mapping
	4.1. Global vs. local operator
	4.2. Global Operator: Compression, Gamma & Saturation
	4.3. Global Operator: Tone curve
	4.4. Local Operator: Mask
	4.5. Local Operator: Local Contrast
	4.6. Black & white clip (contrast)
	4.7. Color saturation
	4.8. Color adjustment
	4.9. Vignette
	4.10. 3d LUT – color grading
	4.10.1 Importing 3d LUT files
	4.10.2 Applying 3d LUTs


	5. Layers
	5.1. Managing layers
	5.2. Painting the mask
	5.3. Tone mapping settings

	6. Image transformations
	7. Clone/healing tool
	8. Post processing
	8.1. Gaussian blur (smoothing)
	8.2. Unsharp mask (sharpening)
	8.3. Median filter (noise reduction)
	8.4. Bilateral filter (noise reduction)
	8.5. Sample/target balance

	9. Color management
	10. Batch processing
	10.1. Automatic task list creation

	11. Tone mapping settings management, presets
	12. Saving the result
	12.1. Exporting to external editor

	13. Saving and restoring projects
	14. Program options
	15. Adobe Lightroom plug-in
	15.1. Installation and setup
	15.2. Plug-in usage


